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実験の目的，注意，参考書

• 目的

– ハードウェアおよびソフトウェアからのアプローチを通じて，
組み込みシステムに関する知識と技術を習得する．

• 注意

– 計算機アーキテクチャ第一 (6学期,○, 2-0-0)
オペレーティングシステム (6学期,○, 2-0-0)
を履修しておくことが望ましい．

• 参考書

– コンピュータの構成と設計 第3版，パターソン＆ヘネシー (成田光彰 訳)，
日経ＢＰ社，2006

– オペレーティングシステム設計と実装 第3版，A.S.タネンバウム，A.S.ウッ
ドハル，ピアソン・エデュケーション，2007
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情報実験第四 「組み込みシステム」 実験の概要

サーバ計算機(Linux)
MIPSプロセッサのクロス開発環境

情報ネットワーク演習室 (Windows7)
FPGA開発，アプリケーション開発，CAD利用

組み込みシステムHWキット
（１人１台を提供）

（３）基板実装，
はんだ付け

組み込みシステムHW

（４）FPGA開発，プロセッサ開発
(Verilog HDL)

（５）リモートログイン
MIPSアプリケーション開発

（５）アプリケーション検証
組み込みシステム開発

（６）組み込みシステムコンテスト
優れたシステムを表彰

（１）回路図エディタの利用

（２）プリント基板エディタの利用
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実験スケジュール，実施場所

1. 実験の説明，セットアップ等 【Ａ】

2. 組み込みシステムHWの制作と動作確認 【Ｂ】

3. 組み込みシステムHWの制作と動作確認 【Ｂ】

4. ハードウェア記述言語によるFPGA開発 【Ａ】

5. FPGAへのプロセッサの実装 【Ａ】

6. アセンブラによる組み込みアプリケーション開発 【Ａ】

7. アセンブラによる組み込みアプリケーション開発 【Ａ】

8. C言語による組み込みアプリケーション開発 【Ａ】

9. C言語による組み込みアプリケーション開発 【Ａ】

10. 組み込みシステム開発 【Ａ】

11. 組み込みシステム開発 【Ａ】

12. 組み込みシステムコンテスト 【Ａ】
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【Ａ】 は，情報ネットワーク演習室 第２演習室（大岡山 南4号館 3階） で実施．
【Ｂ】 は，VLSI設計室 http://www.vdc.ss.titech.ac.jp/ で実施．

9:40 に集合（実験時間 9:45～12:15）してください．開始時に出席をとります．
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情報実験第四 「組み込みシステム」 補足

• 実験設備の制約から，最大受け入れ数を２０人とします．

• チーム制ではなく，１人で１台のハードウェアを利用します．

• 質問などは以下のアドレスにメールを送信してください．

– emb_at_arch.cs.titech.ac.jp

• 本スライドで (CPX) 

は，チェックポイントを意味します．ここにたどり着いたら，
TAに知らせてください．
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セットアップ（１）
教育用電子計算機システムのアカウント設定
セットアップ（１）
教育用電子計算機システムのアカウント設定
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教育用電子計算機システムのアカウント設定

• TSUBAMEのアカウント，教育用電子計算機システムのアカウントは
共通です．

• TSUBAMEのアカウントが有る場合には，それを使ってログイン．アカウント設定
の作業は必要ありません．

• TSUBAMEのアカウントが無い場合には，その取得が必要です．

• こちらを参照して，アカウントを設定してください．

– http://edu.gsic.titech.ac.jp/?q=account

– 0. 教育システムの端末に申請用アカウントでログインする．

– 3. TSUBAMEアカウントを取得する．

– 4. ログオフして教育システム端末に再度ログインする．

8
わからない時はTA/教員に質問
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セットアップ（２）
実験で利用するファイルのコピー
セットアップ（２）
実験で利用するファイルのコピー
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実験で利用するファイルのコピー

• TAからUSBメモリを借りる．

• USBメモリを端末に挿入し，「Emb ディレクトリ」のすべてのファイルを
Zドライブにコピーする．

• USBメモリを返却する．

• 実験のディレクトリ構成

– Emb
• Doc   ・・・ 実験のためドキュメントを格納

• Exe ・・・ 実行プログラムなど

• ISE ・・・ FPGA用のプロジェクトファイルなど

• Circuit ・・・ 回路図など

• SDK ・・・ アセンブリ言語/Ｃ言語のアプリケーション開発用

• Bitfile ・・・ FPGA用の構成ファイルなど
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このファイルは Z:¥Emb¥Doc¥Emb-Jikken.ppt
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セットアップ（３）
組み込みシステムHWキットの確認
セットアップ（３）
組み込みシステムHWキットの確認
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組み込みシステムHWキットの確認（１／２）

• 以下のすべての部品が揃っていることを確認する．

• 部品は丁寧に扱うこと．

– ピンセット

– はんだ

– はんだ吸取線

– 竹串（３本）

– プラスチック片

– 電池ボックス

– プリント基板

– 単三電池 ４本

不足部品がある場合にはTA/教員に尋ねる． 12東京工業大学 情報工学科 情報実験第四「組み込みシステム」



組み込みシステムキットの確認（２／２）

• 以下のすべての部品が揃っていることを確認する．

– FPGA
– SRAM
– PROM
– レギュレータ 2個(PQFJ, T42の刻印)

– 液晶モジュール ZY-FGD1442701V1
コントローラIC：ST7735

– スペーサとネジ 4組

– チップ抵抗 102 10個，472 10個, 511 5個
– チップコンデンサ 105 3個，103 2個

(チップコンデンサには刻印が無いので注意）

– 発光ダイオード 6個

– 6ピンヘッダ，2ピンヘッダ

– スイッチ 3個
– 40MHz クロックオシレータ

– SDカードスロット
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回路図エディタの使い方回路図エディタの使い方
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回路図エディタ BSch3V

• 目的： 回路図エディタの使い方を学ぶ．実装するシステムの回路図表現を把握する．

• ソフトウェアの起動

– Z:¥Emb¥Exe¥bs3vp¥bsch3v.exe
– 概要や使い方は次を参照

• Z:¥Emb¥Exe¥bs3vp¥README.htm
• ファイル（MieruEMB System Board V1.1の回路図）を読み込む．

– Z:¥Emb¥Circuit¥MieruEMBV11a.CE3

15MieruEMB System Board V1.1の回路図
MieruEMB System Board V1.1
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システムボードの回路図修正

• 回路図を修正（ダイオードと抵抗を追加する）し，
Emb/Circuit/MieruEMBV11b.CE として保存

• 右下に，名前，今日の日付を記入

• 回路図を印刷 (CP1)
– 本スライド最後の「Check Point確認シート」も印刷
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システムボードの回路図
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レギュレータ
3.3V から 2.5 
Vを生成

オシレータ
40MHz のクロックを生成

レギュレータ
3.3V から 1.2 Vを生成

液晶モジュール
128 x 128 ピクセル

FPGA Spartan-3EPROM (FPGAの構成情
報を格納するROM)

SRAM

スイッチ
（プルアップ）

電源LED

JTAG端子，FPGA, 
PROMに書き込む

ユーザ用LED

汎用 I/O

SDカードアダプタ



情報ネットワーク演習室における印刷

• 印刷した資料はファイリングして実験時に持参すること．

• プリンタの利用については次を参照

– http://edu.gsic.titech.ac.jp/?q=printer

• 年間のプリント可能枚数に制限がある（今年は２００枚）ので注意．

• 実験 ２日目～３日目 「組み込みシステムHWの実装」
の全てのスライドを印刷して，VLSI設計室に持参すること．
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プリント基板エディタの使い方プリント基板エディタの使い方
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プリント基板エディタ PCBE

• 目的： プリント基板エディタの使い方を学ぶ．利用するプリント基板の構成を把握する．

• ソフトウェアの起動

– Z:¥Emb¥Exe¥pcbe¥pcbe.exe
• ファイル（MieruEMB System Board V1.1のデータ）を読み込む．

– Z:¥Emb¥Circuit¥MieruEMBV11a.pcb
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プリント基板エディタ PCBE

• MieruEMB System Board V1.1
– 半田面（表），部品面（裏）の2層で設計

• MieruEMB System Board V1.1 のレイヤー設定

– レイヤー 1 : 半田面パターン

– レイヤー 2 : 部品面パターン

– レイヤー 3 : 半田面シルク

– レイヤー 4 : 部品面シルク

– レイヤー 5 : 半田面レジスト

– レイヤー 6 : 部品面レジスト

– レイヤー 7 : 外形

– レイヤー 8 : 孔
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部品面（表）

• レイヤー 2, 4, 6, 7 （部品面パターン，部品面シルク，部品面レジスト，外形）
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FPGA Spartan-3E

PROM (FPGAの構成情
報を格納するROM)

SRAM

液晶モジュール
128 x 128 ピクセル

オシレータ
40MHz のクロックを生成

レギュレータ
3.3V から 2.5 
Vを生成

レギュレータ
3.3V から 1.2 Vを生成

JTAG端子，FPGA, 
PROMに書き込む

スイッチ
（プルアップ）

SDカードアダプタ

汎用 I/O

ユーザ用LED



半田面（裏）

• レイヤー 1, 3, 5, 7 （半田面パターン，半田面シルク，半田面レジスト，外形）
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プリント基板エディタ PCBE

• LED周辺(D2, D3, D4, D5) に配線を追加．

– Z:¥Emb¥Circuit¥MieruEMBV11b.pcb として保存

• レイヤー 2, 4, 6, 7 を選択して印刷． (CP2)
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実験 ２日目～３日目実験 ２日目～３日目
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組み込みシステムHWの実装組み込みシステムHWの実装
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1. チップ抵抗，コンデンサ，ダイオードの固定方法

• プラスチック片に接着剤をのせる．

• 竹串の先に少量の接着剤をつける．

• 基板の部品固定部分に接着剤をぬる．

• ピンセットを使って部品を固定する．

部品を固定場所に置いて，接着剤の付いていな
い別の竹串で抑えるとうまくいく．
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接着剤は少量で大丈夫



1. チップ抵抗，コンデンサ，ダイオードの固定（30～50分）

• (a) チップ抵抗を固定

– 472 (4.7KΩ) 8個
– 102 (1KΩ) 9個
– 512 (510Ω) 3個

• R20 330 は 511(510Ω)を使う．

• (c) チップコンデンサの固定

– C1 と C2 は 105 (3個入りのパッケージ)  2個
– C3 は 103 (2個入りのパッケージ)          1個
– を使う．要注意．

• (b) ダイオードの固定 5個
– ダイオードには極性がある（正しい方向で固定）．

– 黒色のマークがある方をGND側にする．

• 全てのチップ抵抗，チップコンデンサ，
ダイオードを固定(CP3)
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写真ははんだ付け後のもの，ダイオードの向きに注意

写真ははんだ付け後のもの，ダイオードの向きに注意



2. チップ抵抗，コンデンサ，ダイオードのはんだ付け方法

• はんだごてに，単三電池 4本をセットする．

• こて台に少量の水を入れる．

• はんだ付けする部分にフラックスをぬる．

• はんだ付けする．

• はんだごての先は熱いのでやけど
に注意すること．

フラックス（上）とはんだごて（下）

奥のチップ抵抗(R18)のはんだ付けをしたところ．
手前(R17)は固定したところ．
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こて台



2. チップ抵抗，コンデンサ，ダイオードのはんだ付け（20～40分）

• 固定したチップ抵抗，コンデンサ，ダイオードのはんだ付け (CP4) 

30

3.3Vの供給により，
POWER LED (D1)が点灯することを確認．
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3. オシレータ，レギュレータ，ICの固定 （30～50分）
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(c) PROM (d) SRAM

(e) FPGA
写真ははんだ付け後のもの
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(a) オシレータ (b) レギュレータ ２個 （異なる部品なので固定場所に注意）



3. オシレータ，レギュレータ，ICの固定 （30～50分）

• 悪い例
– FPGAが右側に寄っている．

– ２つのピンがショートするため，正しく動作しない．
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3. オシレータ，レギュレータ，ICの固定 （30～50分）

• 接着剤を用いて，オシレータ，レギュレータ，ICを固定

– (a) クロックオシレータ

• 方向に注意．右写真，丸印が左下になる．

– (b) レギュレータ

• PJFQの刻印のあるものを上，
T42と刻印のあるものを下に．

– (c) PROM
• 丸印が左上になるように．

• ピンを確実に接続するように位置調整．

– (d) SRAM
• 丸印が左上になるように．

• ピンを確実に接続するように位置調整．

– (e) FPGA
• 丸印(大）が左下，丸印（小）が右上

• Xilinxの文字が下を向くように．

• ピンを確実に接続するように位置調整．

(CP5)

33FPGA
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(a)

(b) PJFQ

(b) 
T42

(c)

(d)(e)



4. オシレータ，レギュレータ，ICのはんだ付け（30～50分）

• オシレータ，レギュレータ，ICのはんだ付け

– 多量のフラックスを利用する．

– ２本のピンが接続されるブリッジがおきないように．

– はんだが多すぎる場合には，はんだ吸取線を使う．

• (CP6)
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5. 液晶モジュール等のはんだ付け （30～50分）

• 液晶モジュール等のはんだ付け

– (a) 液晶モジュール

• 位置を慎重に固定して，
基板にはんだをもる．フラックスをぬる．

• 液晶モジュールの上からはんだ付け．

– (b) スイッチ

• ３個のスイッチをはんだ付け．

– (c) SDカードスロット

• 基板裏面に，SDカードスロットをはんだ付け．

– (d) 6ピンヘッダ

• 基板裏面に，6ピンヘッダをはんだ付け

– (e) 2ピンヘッダ

• 基板裏面に，2ピンヘッダをはんだ付け

– (d) スペーサ

• ネジで4個のスペーサを固定する．

• (CP7)
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裏面にはんだ付け

裏面にはんだ付け

裏面にはんだ付け



動作確認

• テスターを用いて電圧を確認

– 2.5V
– 1.2V

• FPGAの動作確認

• PROMの動作確認

• スイッチの動作確認

• LEDの動作確認

• 液晶モジュールの動作確認

• SDカードの動作確認

• テスターの操作マニュアルは以下

– http://akizukidenshi.com/download/P-10manual.pdf
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実験 ４日目～５日目実験 ４日目～５日目
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Digilent Adeptの使い方Digilent Adeptの使い方
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Digilent Adept

• FPGAの構成データをFPGAやPROMに書き込むソフトウェア

• ソフトウェアの起動

– C:¥Program Files¥Digilent¥Adept¥Adept.exe
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FPGAへの書き込み準備

• JTAGケーブルを計算機のUSBポートに接続する．

• JTAGケーブルと組み込みシステムHWを接続する．

– 方向に注意，6ピンを確実に接続

– 間違えると，ケーブル破損することがある

• 組み込みシステムHWの電源を入れる．

• Digilent Adept の Initialize Chain ボタンを押す．

• Adept に PROM, FPGA が表示される．
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JTAGケーブル
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FPGA/PROMへの書き込み

• FPGA右の Browseボタンをクリック．

– Z:¥Emb¥Bitfile¥main01.bit を選択

– “Startup clock for this file is … “ といったメッセージには Yes をクリック．

– Programボタンをクリックすると，FPGAに回路情報が書き込まれる．

– FPGAは揮発性なので，電源を切ると回路情報が消えてしまう．

– 不揮発性のPROMに書き込むと，電源投入時に自動でその回路情報がFPGAにロー
ドされる．
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main01.bit には D2, D4が点灯する回路情報が格納されている．



Xilinx ISE WebPACKの設定Xilinx ISE WebPACKの設定
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Xilinx ISE WebPACK ライセンスファイルの設定

• ISE WebPACKを起動してライセンスファイルを設定する．

– Help → Manage License
– Copy Licenseボタンをクリック

– Z:¥Emb¥Doc¥Xilinx.lic を選択

• ライセンスファイルがZドライブにコピーされて，利用可能になる．
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ISE WebPACKを用いたFPGA開発(1)ISE WebPACKを用いたFPGA開発(1)
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ISE Project Navigator の起動，プロジェクトの新規作成

• New Project ボタンをクリック

45東京工業大学 情報工学科 情報実験第四「組み込みシステム」



プロジェクトを保存するディレクトリを指定

• ドライブはZドライブを用いるので，
Location に，Z:¥Emb¥ise を指定，Name に， main01 を指定する．

• Next ボタンをクリック
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利用するFPGA等の設定

• 利用するFPGAの種類などを正確に指定する．

• 上から， All, Spartan3E, XC3S500E, VQ100, -4, XST, ISim, 
Verilog, Store all values, VHDL-93

• Nextボタンをクリック， 確認画面で Finishボタンをクリック
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Verilogソースコードの追加

• Project -> New Source を選択

• New Source Wizard にて，Verilog Module を選択し，ファイル名 main.v を
入力し，Nextボタンをクリック
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Verilogソースコードの追加

• Define Module では，何も入力せずに，Nextボタンをクリック

• サマリが表示される． Finishボタンをクリック
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Verilog HDLの編集

• module main を編集する．
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UCF(User Constraints File)の追加

• Project -> New Source を選択

• New Source Wizard にて，Implementation Constraints File を選択し，フ
ァイル名 main.ucf を入力し，Nextボタンをクリック

• サマリが表示される．Finishボタンをクリック
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UCFの追加と編集の準備

• Hierarchy の main 左の + をクリック

• main.ucf が現れる．

• main.ucf の上でダブルクリック， main.ucf が編集可能となる．
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UCFの編集

• UCFを右図の様に編集して保存，
保存は 「Ctrl + S」のショートカット，または，File -> Save を選択
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論理合成

• main (main.v) をクリックすると，Processes に項目が表示される．

• Processes: main から，Generate Programming File をダブルクリック，論理合成を始め
る．

• しばらくすると， Generate Programming File の左に緑のチェックが表示されれば成功．
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FPGA/PROMへの書き込み

• Digilent Adept を起動，FPGA右の Browseボタンをクリック．

– Z:¥Emb¥ise¥main01¥main.bit を選択

– Programボタンをクリックすると，FPGAに回路情報が書き込まれる．

– FPGAは揮発性なので，電源を切ると回路情報が消えてしまう．

– 不揮発性のPROMに書き込むと，電源投入時に自動でその回路情報が
FPGAにロードされる．
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main01.bit には D2, D4が点灯する回路情報が格納されている．



Verilog HDLの修正

• 24行目の ULED = 5; の値を変更して，どのような変化が起きるか試してみる．

56

2進数で記述すると，
assign ULED = 2’b101; となる．



ISE WebPACKを用いたFPGA開発(2)ISE WebPACKを用いたFPGA開発(2)
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シンプルな回路（AND回路とOR回路）の例

• 先の例と同様に，
Z:¥Emb¥ise¥main02 のプロジェクトを作成

• main.v と main.ucf を示す様に入力し，論理合成，FPGAに書き込む．

• スイッチを押して，LEDがどのように変化するか確認する．
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回路の確認

• Synthesis –XST から，View RTL Schematic をダブルクリック

• ブロック図の main をダブルクリック

• AND回路，OR回路（3入力）が生成されていることを確認できる．
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ISE WebPACKを用いたFPGA開発(3)ISE WebPACKを用いたFPGA開発(3)
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LEDを点滅させる回路（順序回路の例）

• 新規に，Z:¥Emb¥ise¥main03 のプロジェクトを作成

• 入力の CLK は，40MHz のクロック

• main.v と main.ucf を示す様に入力し，論理合成，FPGAに書き込む．
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ナイトライダー回路ナイトライダー回路
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液晶モジュールのサンプルプロジェクト lcd01

• File → Open Project
– Z:¥Emb¥ISE¥lcd01¥fpga¥main.xise

• 論理合成して，FPGAに書き込み．
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液晶モジュールのサンプルプロジェクト lcd01
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MieruEMB.v 64

• minilcd_con の利用方法

– VRAM_ADDR に 14ビットのアドレスを指定

– VRAM_DATA に 3ビットの色データを指定
ただし，4ビット幅で接続

– VRAM_WE を 1 にすることで，そのアドレスに指
定色を書き込む．

• 色は Red, Green, Blue それぞれ1ビットの3ビットで表
現．8色を表示可能

– 例えば，3’b111 は白色，3’b100 は赤色，3’b000
は黒色

– Verilog HDLの擬似コード
wire red, green, blue;
wire [2:0] color;
assign color = {reg, green, blue};

• アドレスは14ビットで表現

– 128 x 128ピクセル

– 液晶の左上を (0, 0) ， 右下を (127, 127) とし
て，(x, y) のピクセルのアドレス ADDR は，以下
で定義

– ADDR = y*128 + x
– Verilog HDL の擬似コード

wire [6:0] x, y;
wire [13:0] addr;
assign addr = {y, x};

cnt[14] をクロックとして
利用している点に注意．

clockgen は，40MHz のクロックから，
30MHz のクロック FCLK を生成．



液晶モジュールのサンプルプロジェクト lcd01
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液晶モジュールのサンプルプロジェクト lcd02

• File → Open Project
– Z:¥Emb¥ISE¥lcd02¥fpga¥main.xise

• 論理合成して，FPGAに書き込み．
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ゆっくりと白い線が描かれていく．



液晶モジュールのサンプルプロジェクト lcd02
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MieruEMB.v 67

• C言語の擬似コード

int x = 0;
int y = 33;
int color = 7;

while(1) {
x++;
draw_dot(x, y, color);

}

cnt[22] をクロックとして
利用している点に注意．

resetgen は，リセット信号 RST_X を生成．
3個のスイッチが押されるとリセットとしている．



ナイトライダー回路

• File → Open Project
– Z:¥Emb¥ISE¥lcd03¥fpga¥main.xise

• lcd03 は，先のlcd02と同じ内容．これをベースに編集する．

• MieruEMB.v を編集して，画面上に，ドットが左右に反射しながら移動する回路
を作成する．

• ナイトライダー回路の動作確認 (CP8) 
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FPGAへのプロセッサの実装FPGAへのプロセッサの実装
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MieruEmb System V1.0

• FPGA XC3S500E-4VQG100C
– プロセッサコア

• MIPS32準拠（浮動小数点演算なし，キャッシュなし）

• マルチサイクル，MieruPC-2010のプロセッサコアをベース

• 30MHz クロック

– SRAMコントローラ

– I/Oコントローラ

– Mini-LCDコントローラ

• Mini-LCD ZY-FGD1442701V1
– 128 x 128 pixel, 8色カラー, Video RAM (8KB)

• SRAM CY7C1049DV33-10ZSXI 
– 512KB (152 x 8)

• MieruEMB System Board V1.1

• LED
– D4は一定間隔で点滅，D3はスイッチのどれかが押された時に点灯，D2はSDの読み込みが完了するまで点灯
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MieruEMB System V1.0

• File → Open Project
– Z:¥Emb¥ISE¥emb01¥fpga¥fpga.xise         (test64)

• 論理合成して，PROMに書き込み．

• TAから SDカード と SDカードアダプタ を受け取る．

– MieruEMBシステムにSDカードを挿入して起動 (CP9)
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SDカードとアダプタ 125_space
Z:¥Emb¥Bitfile¥125space.bit



実験 ６日目～９日目実験 ６日目～９日目
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実験用サーバ計算機
（MIPSクロス開発環境）の使い方
実験用サーバ計算機
（MIPSクロス開発環境）の使い方
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実験用サーバ計算機（MIPSクロス開発環境）

• サーバ計算機 serv.arch.cs.titech.ac.jp
– アカウント名，パスワードをTAから受け取ってください．

• MIPSクロス開発環境

– 構築方法はこちら http://www.arch.cs.titech.ac.jp/mcore/buildroot.html
– /home/share/cad/mipsel/usr/bin/

• mipsel-linux-gcc
• mipsel-linux-as
• mipsel-linux-ld
• mipsel-linux-objdump など

• サーバにログイン putty を起動

– Z:¥Emb¥Exe¥putty¥putty.exe

• ファイル転送には WinSCP を使う

– Z:¥Emb¥Exe¥winscp¥WinSCP.exe
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SDカードの使い方と初期化方法

• MieruEMBシステム (MieruPC-2010)
– SRAMを512KBのメインメモリとして利用．

– 8MBのSDカードを利用．

– 電源投入時およびリセット時に，SDカードから512KBのデータをメインメモリにコピーして，実行を
開始する．

– SDカードのブロックサイズを512Bとして，81～1104番目のブロックをメインメモリにコピー．

– SDカードからはSPI(Serial Peripheral Interface)モードにて読み出し．

• Windows 7 / XP
– SDカードをフォーマットして，ファイルをコピーすると，

経験上，最初のファイルのデータは 81番目のブロックから格納されることが知られている．

– ただし，まれに，そうでない場合がある．この場合には，次の方法で，SDカードを初期化する（すべ
てのブロックに適切なデータを書き込む）必要がある．

• WindowsにおけるSDカードの初期化（全ブロックへの書き込み）

– SDカードが Dドライブ とすると，コマンドプロンプトで以下のコマンドを使う．ドライブ名を間違えると
システムが破壊されるので，細心の注意を．

– cd Z:¥Emb¥Exe¥dd      (http://www.chrysocome.net/dd からダウンロードしたもの)
– $ dd if=master.dat of=¥¥.¥d:
– その後，Windows で通常通りフォーマットする．
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アセンブラによる
組み込みアプリケーション開発
アセンブラによる
組み込みアプリケーション開発
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Adapted from Computer Organization and Design,  Patterson & Hennessy, © 2005
77

MIPS I (MIPS R3000)
Instruction Set Architecture (ISA)

Instruction Categories
Computational 
Load / Store
Jump and Branch
Floating Point

coprocessor

Memory Management
Special

R0 - R31

PC
HI
LO

Registers

OP

OP

OP

rs rt rd sa funct

rs rt immediate

jump target

3 Instruction Formats: all 32 bits wide

R format

I format

J format



Adapted from Computer Organization and Design,  Patterson & Hennessy, © 2005
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MIPS Arithmetic Instructions

MIPS assembly language arithmetic statement
add $t0, $s1, $s2

sub $t0, $s1, $s2

Each arithmetic instruction performs only one operation
Each arithmetic instruction fits in 32 bits and specifies 
exactly three operands

destination  ← source1    op source2

Each arithmetic instruction performs only one operation
Each arithmetic instruction fits in 32 bits and specifies 
exactly three operands

destination  ← source1    op source2

Operand order is fixed (destination first)
Those operands are contained in the 
register file ($t0,$s1,$s2) – indicated by $



Adapted from Computer Organization and Design,  Patterson & Hennessy, © 2005
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MIPS Memory Access Instructions

MIPS has two basic data transfer instructions for accessing 
memory
lw  $t0, 4($s3)  # load word from memory

sw  $t0, 8($s3)  # store word to memory

The data is loaded into (lw) or stored from (sw) a register in 
the register file
The memory address – a 32 bit address – is formed by 
adding the contents of the base address register to the offset
value

A 16-bit field is limited to memory locations within a region of ±213 or 
8,192 words (±215 or 32,768 bytes) of the address in the base register



Adapted from Computer Organization and Design,  Patterson & Hennessy, © 2005
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MIPS conditional branch instructions:
bne $s0, $s1, Lbl #go to Lbl if $s0≠$s1 
beq $s0, $s1, Lbl #go to Lbl if $s0=$s1

Ex: if (i==j) h = i + j;

bne $s0, $s1, Lbl1
add $s3, $s0, $s1

Lbl1: ...

MIPS Control Flow Instructions

Instruction Format (I format):

op            rs             rt                 16 bit offset

How is the branch destination address specified?



メモリマップドI/O

• MieruEmb System では，メモリマップドI/O（Memory Mapped I/O）を採用

– メモリのリード，ライトのための命令(load, store)を入出力機器にも利用

– 0x00000 ～ 0x7ffff の512KB は SRAMの物理メモリに割り当て

– 0x80000 ～ 0x7fffff は未定義

– 0x800000 以降は，メモリマップドI/Oに割り当て

• 0x80010C : 1KHz タイマ

• 0x8001f0 : GPIO[0] 汎用入出力

• 0x8001f1 : GPIO[1] 汎用入出力

• 0x8001fc : SW[0] スイッチ

• 0x8001fd : SW[1] スイッチ

• 0x8001fe : SW[2] スイッチ

• 0x8001ff : GPIN 汎用入力

• 0x900000 ～ 0x903fff : LCD用ビデオメモリ 16KB (1byte/1pixel)
– 液晶に描くためには，この領域にストアすればよい．

– 液晶の左上を (0, 0) ， 右下を (127, 127) として，(x, y) のピクセルのアドレス ADDR は，次式で定義

– ADDR = 0x900000 + y*128 + x
– バイト単位で書き込み，ただし色は3ビットで指定するため下位3ビットのみが有効となる．
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MIPS命令セットアーキテクチャ

• MIPS Reference Card を印刷

– Z:¥Emb¥Doc¥mipsref.pdf

• アセンブリ言語による開発の準備

– Z:¥Emb¥SDK/asm の内容を
サーバ計算機の /home/username/Emb/SDK/asm にコピー

• Putty にてサーバ計算機にログイン

– cd ~/Emb/SDK/asm/001_dot/
– emacs, vi などでファイルを編集，コンパイル

（Windows 上で編集して，サーバ計算機にコピーしてもOK）
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001_dot: ドットを描くプログラム
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Makefile

• サーバ計算機にて

– cd ~/Emb/asm/001_dot/
– make コマンドにて，init.bin が生成される．

• WinSCP で init.bin をSDカードにコピー

• MieruEMBにて起動

• サーバ計算機にて

– make dump で，オブジェクトダンプ

– make clean で生成したファイルお削除

– make image はMIPSの実行ファイルを
MieruEMBのSDに書き込むメモリ
イメージを生成する．

– make read は ELF の情報を読む．

memgen は独自開発のプログラム，コードは以下
Z:¥Emb¥SDK¥etc¥memgen¥



001_dot: ドットを描くプログラム
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start.S

main.S

~/Emb/SDK/asm/001_dot/main.S

ドット

すべてのレジスタを
値０で初期化する．

スタックポインタの値
を適切に設定し，ジャンプ

メモリへのストアにより
ドットを描く



001_dot: ドットを描くプログラム
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リンカスクリプトとディスアセンブル出力

make dump
コマンドによりディスアセンブル

stdld.script



002_bar: カラーバーを描くプログラム
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main.S

~/Emb/SDK/asm/002_bar/main.S
遅延分岐の影響を排除するため，分岐とジャンプの後には nop を挿入すること．



ナイトライダー（アセンブリ言語版）

• Z:¥Emb¥SDK¥asm¥003_night¥main.S
– 002_bar と同じ内容．これをベースに編集する．

• アセンブリ言語にて，画面上に，ドットが左右に反射しながら移動する回路を作
成する．

– 美しくみえる様に修正する．

• ナイトライダーの動作確認 (CP10) 
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Ｃ言語による
組み込みアプリケーション開発
Ｃ言語による
組み込みアプリケーション開発
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101_dot: ドットを描くプログラム（Ｃ言語版）
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main.c

Z:¥Emb¥SDK¥app¥101_dot¥main.c

メモリマップドI/Oの
ための変数の定義

x,y で指定したドットを白色にする．



102_bar: カラーバーを描くプログラム（Ｃ言語版）

main.c

90

Z:¥Emb¥SDK¥app¥102_bar¥main.c



103_aba: 文字を表示するプログラム（Ｃ言語版）

main.c
91

Z:¥Emb¥SDK¥app¥103_aba¥main.c

x,y で指定した場所に色 7 にて，A という文字を表示．

文字 A のフォントデータ．

文字 B のフォントデータ．



104_pic : 画像表示とスイッチ入力のサンプル（Ｃ言語版）

• SW1 左移動， SW2 上移動，SW3 右移動， SW1 & SW3 下移動
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Z:¥Emb¥SDK¥app¥104_pic¥



ナイトライダー（Ｃ言語版）

• Emb¥SDK¥app¥200_night¥
– 104_pic と同じプログラム，これをベースに修正．

• Ｃ言語にて，画面上に，ドットが左右に反射しながら移動する回路を作成する．

– 美しくみえる様に修正する．

• ナイトライダーの動作確認 (CP11) 

• ナイトライダーを，（１）Verilog HDLによるハードウェア実装，（２）アセンブリ言語

によるソフトウェア実装，（３）Ｃ言語によるソフトウェア実装という３種類で記述し
た．
それぞれの利点，欠点を考えてみる．

• app 以下にたくさんのサンプルプログラムがあるのでこれらを動かしてみる．

– 106_fig, 107_gpio, 125_space など
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組み込みシステムの仕様策定

• 実装する組み込みシステムの仕様書（Ａ４で１枚程度）を作成する．

• 仕様書を印刷 (CP12)

• 目的（用途）

• 実装ヵ所

– ハードウェア

• センサーの追加，コントローラの追加，I/Oの追加

– FPGA
• プロセッサの高速化・高性能化，I/Oの高性能化・高速化

• 命令キャッシュの実装

– ソフトウェア

• アセンブリ言語，Ｃ言語

• ファイルシステム

• オペレーティングシステム
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センサーの追加： 光センサの接続例

• 光センサ（フォトトランジスタ） NJL7502L
– 明るい時，フォトトランジスタに電流が流れる．

– 暗くなるとGPIOの入力がLOWになる．
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実験 １０日目～１１日目実験 １０日目～１１日目
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組み込みシステム開発組み込みシステム開発
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実験 １２日目実験 １２日目
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組み込みシステムコンテスト

• １人５分の持ち時間

– PowerPointのスライドを用いた３分間のプレゼンテーション

– 組み込みシステム（実機）を用いた２分間のプレゼンテーション

• 参加学生 ２０名の投票（1人，2件に投票）により，優秀なシステムを決定

– 最優秀賞

– 優秀賞

• 評価基準

– アイデア（新規性），実用性（有用性），完成度

– これらを伝えるプレゼンテーション能力も重要

• 教員の評価により，幾つかの賞を授与
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補足補足
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参考資料，参考URL

• 東工大 情報工学科 情報実験第四 組み込みシステムのホームページ

– www.arch.cs.titech.ac.jp/lecture/emb/
• プリント基板製造 P板.com

– http://www.p-ban.com/
• 秋月電子通商

– http://akizukidenshi.com/
• 千石電商

– http://www.sengoku.co.jp/
• 東京エレクトロンデバイス株式会社

– http://www.teldevice.co.jp/
• ザイリンクス株式会社

– http://japan.xilinx.com/
• Digilent Inc.

– http://www.digilentinc.com/
• Digi-Key Corporation

– http://jp.digikey.com/
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参考資料，参考URL

• Xilinx FPGA XC3S500E-4VQG100C
– ザイリンクス DS312 Spartan-3E FPGA ファミリ データシート

• SRAM CY7C1049DV33-10ZSXI 
– CY7C1049DV33データシート

• Mini-LCD ZY-FGD1442701V1
– http://www.aitendo.co.jp/product/1621
– コントローラIC ST7735

• フォトトランジスタ NJL7502L
– http://akizukidenshi.com/catalog/g/gI-02325/

• クロックオシレータ 40MHz
– http://akizukidenshi.com/catalog/g/gP-03617/

• SDカード 8MB
– http://akizukidenshi.com/catalog/g/gS-02549/

• スペーサ，ネジ

– http://akizukidenshi.com/catalog/g/gP-01861/
• タクトスイッチ

– http://akizukidenshi.com/catalog/g/gP-01282/
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参考資料，参考URL

• 電池ボックス

– http://akizukidenshi.com/catalog/g/gP-00310/
• チップLED 赤

– http://www.sengoku.co.jp/mod/sgk_cart/search.php?multi=TLRE1002A&cond8
• チップ抵抗

– http://www.sengoku.co.jp/mod/sgk_cart/search.php?multi=ERJ6GEYJ
• コンフィギュレーションケーブル

– http://www.digilentinc.com/Products/Detail.cfm?NavPath=2,395,523&Prod=JTAG-USB
• MIPS32のクロス開発環境の構築

– http://www.arch.cs.titech.ac.jp/mcore/buildroot.html
• dd for windows

– http://www.chrysocome.net/dd
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Check Point 確認シート
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名前

CP1 回路図の修正と印刷

学籍番号

CP2 プリント基板の修正

CP3 チップ抵抗などの固定

CP4 チップ抵抗などのはんだ付け

CP5 FPGAなどの固定

CP6 FPGAなどのはんだ付け

CP7 液晶などのはんだ付け

CP8 FPGA版ナイトライダー回路

CP9 MieruEMBの動作確認

CP10 アセンブリ言語版ナイトライダー

CP11 Ｃ言語版ナイトライダー

CP12 組み込みシステム仕様策定

日付 時刻 TAサイン

2011-10-07 10:45 Kise記入例


